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Read the user manual before using the instrument
Before using the MACSQuant® Tyto® Instrument, read the chapter Important safety information in the
MACSQuant Tyto user manual and all other information contained in this user manual, including any safety and
operating instructions. Pay special attention to all warnings displayed on the instrument. Failure to read and
follow these guidelines could lead to improper or incorrect usage and result in damage to the instrument.
Improper usage could also cause severe personal injury, death, unpredictable results, instrument malfunction,
and premature wear to components shortening the lifetime of the instrument. Such actions may void your
warranty. Keep the user manual and any other safety and operating instructions provided with the instrument
in a safe place accessible to all users for future reference.
If you have a serious concern regarding the safe use of your instrument, please contact your authorized
Miltenyi Biotec service provider or call Miltenyi Biotec Technical Support.
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STARTUP, SHUTDOWN AND,
BASIC FUNCTIONS

1
Startup, shutdown,
and basic functions
1.1

1

Instrument startup
1 Ensure that the MACSQuant® Tyto® Instrument main power switch at the rear is in the on-position 'I'.

Note:

The system will be in standby mode, indicated by a red LED on the orange touchscreen monitor.

2 Turn on the MACSQuant Tyto Instrument by tapping the orange touchscreen monitor.

1.2

Boot the software
1 Launch the MACSQuantify™ Tyto® Software by double-clicking the MACSQuantify™ Software icon on the
desktop.

2 After logging on to the MACSQuantify™ Tyto® Software, wait for the camera on the orange touchscreen
monitor to turn on before proceeding. Three crosses (red, blue and violet), indicating the location of the
different lasers, and an alignment cross (yellow) will appear ( Figure 1.1).

Figure 1.1: Camera view on touchscreen monitor
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User interface overview

STARTUP SHUTDOWN
BASIC
S

1.3

1

Figure 1.2: General user interface overview

The user interface of the MACSQuantify™ Tyto® Software consists of four main components (Figure 1.2):
l

The menu bar

l

The toolbar

l

The side panel

l

The instrument status bar

The menu bar contains all functions of the software, while the most frequently used functions are located in the
toolbar. The left side panel is dedicated to all instrument and experiment settings. The instrument status bar at the
bottom provides information on the sort outcome parameters as well as a color-coded display of the instrument
status (Figure 1.3). In addition, the three main sorting functions are located in the instrument status bar: The Clear

e t measurement button removes currently measured events during an acquisition. Finally, the functions to
Start/Stop acquisition and Start/stop Sorting are located on the right side of the instrument status bar.

Figure 1.3: Instrument status.

1.4

Shut down
1 To manually shut down the instrument press the Main control on the upper right side of the user interface.

Note:

Always shut down the instrument by pressing the Main control. Upon full instrument shutdown, the
monitor will go to standby mode, until the touchscreen is tapped again.
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2

2.1

CREATE A WORKSPACE

Create a workspace

Description
The MACSQuantify™ Tyto® Software enables users to create different preset files for efficient use of the

2

MACSQuant Tyto Instrument. There are four types of preset files: experiment files, analysis templates,
instrument settings file, and workspaces. Experiment files comprise all experiment data parameters for a
particular experiment. Analysis templates store predefined analysis layouts and are created by defining views
(plots, histograms, statistics and tables) and gating strategies. An instrument settings file consists of calibration
settings (PMT voltage values, channel scales), compensation matrix and trigger selections.
A workspace comprises all of these and, in addition, stores sample lists of data files.
This quick guide explains chronologically how a workspace is created and saved. The basic workflow is as
follows:

1 Select an analysis window,
2 annotate fluorescence channels,
3 set a gating strategy,
4 set PMT voltages,
5 choose trigger and cell speed channel,
6 save the workspace.
In the following sections, we walk you through the different steps involved in creating a workspace along the
example of sorting CD45+/CD3+/CD4+ cells.

9

2.2

Select an analysis window

CREATE A WORKSPACE

1 Click on the New analysis window button in the toolbar to select a plot layout.

2

Figure 2.1: Predefined templates.

2 From the pop-up window, select a layout suitable for sample analysis. In this example, a 3x2 plot layout was
selected (green square in Figure 2.1).

Note:

Two pages of plot displays can be viewed simultaneously on the main field of the user interface.

3 More than two pages can be created and scrolled through two at a time by clicking the window icons in the
oolbar.

4 To close an analysis window, click on the Close button.

2.3

Annotate the fluorescence channels
1 Select the nnotations tab under the main tab Experiment in the side panel (Figure 2.2). This tab
displays the different fluorescence channels (B1 - R2) in the MACSQuant® Tyto®. By default, a fluorochrome
has been set for the channels. Rename the different channels according to the fluorescent labeling used. In
this example, the channels were labeled as: B2: CD45-PE, V1: CD3-VioBlue, R1: CD4-APC.

Figure 2.2: The nnotation tab.
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Create a template
1 Select the desired plot.
2 To change plot types, click the nformation button near the top right corner of each plot and choose
between dot plot, density plot, and histogram under the View ta of the dialog that pops up (Figure 2.3).
CREATE A WORKSPACE

2.4

2

Figure 2.3: Change data display

In our example, two density plots and a histogram are used for the sorting of CD45+/CD3+/CD4+ cells ( Figure

2.4). In the first display, a density plot is selected. By right-clicking on the x-axis, the displayed channel can be
altered to CD45-PE. For the y-axis the Side scatter (SSC) is used. The second plot displays CD3-VioBlue versus
CD4-APC. In the third plot, a histogram on HDR-TOF (Time Of Flight, indicating the time that events travelled
from the trigger laser to the cell speed laser) is selected.

Figure 2.4: Changing the plot axis

3 In the Gating tools in the top

, click the gate you wish to draw on the plots and drag it onto the

appropriate plot.

4 Two gates are necessary for sorting CD45+/CD3+/CD4+ cells. Define the dependency of the different plots as
follows:
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l

First, draw a rectangular gate in the left plot (Figure 2.5).

l

To make the middle plot dependent on the first gate, left-click the header of the plot and select P1.

l

Draw a circular gate in the middle plot. The name P1/P2 confirms the dependency of the P2 gate on the P1
gate.

CREATE A WORKSPACE

5 Choose your sort gate by right-clicking on a gate and select Make sort gate. In this example, the P1/P2
gate is selected as sort gate.

Note:

Alternatively, the sort gate can be selected from the drop-down menu in the Settings under Experiment
in the side panel. Dependency of the different gates can be confirmed in this drop-down menu. Dependent
gates are displayed indented relative to the parent gate. Parallel gates are not indented and displayed on the
same hierarchy level.

2

Figure 2.5: Selecting the sort gate

6 If you wish to change the statistics displayed for a specific gate, click the Information button in that
specific plot.

7 In the Region functions tab, select the gate of interest in the Regions windows.
8 Select the parameters to display in the Functions window.

9 Click OK to close the popup window and return to the analysis window.

2.5

Channel settings
In the Channels tab in the side panel, the trigger channel, cell speed channel and cell speed threshold can be set.
For a detailed description on trigger and cell speed channel, refer to

al e timi

, page 21.

1 Select the radio button behind the channel that you wish to set as a trigger channel. In this example, the B2
channel was set as the trigger channel.
12

2 Set the trigger threshold using the slider under the header Trigger . In this example the trigger threshold is
set at 10.00.

3 Under the Cell Speed Threshold header, select a cell speed channel by choosing a channel from the
drop-down menu.

4 Enter a specific value under Cell Speed Threshold to set the cell speed threshold. In this example the cell

Note:

CREATE A WORKSPACE

speed threshold is set to 40.00.

Determine the cell speed threshold just below your population of interest to have the most accurate TOF for
your target population and therefore the most accurate sort performance.

2

2.6

Save workspace
1

Click the Save file button in the top toolbar to save the workspace.

2 Select Workspace on the left side of the dialog that pops up.
3 Name the new file and click Save.
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CREATE A WORKSPACE

3

3.1

Description
The MACSQuant® Tyto® Instrument allows for cell sorting without the need for specialized technical expertise for
daily operation. Laser alignment, flow control and speed detection are all fully automated and cell sorting can

SET UP A SORT

Set up a sort

be performed by lab professionals without intensive training. This quick guide walks you through the steps to

3

start and finish a sort based on a pre-established workspace.

3.2

Loading instrument and analysis settings
1 Click on the Open file button in the top Toolbar to open a pre-defined workspace.
2 Select Workspace on the left side of the dialog that pops up and open the desired file.
3 The following saved settings will be recalled:

3.3

l

PMT gains

l

trigger and cell speed selections

l

gating strategy

l

compensation matrix

l

analysis settings

Load a MACSQuant® Tyto® Cartridge in the instrument
1 Scan the barcode of the
front of the
S

S

Cartridge using the barcode scanner located on the

15

2 A window pops up confirming successful recognition of the MACSQuant Tyto Cartridge. Click OK or insert
the MACSQuant Tyto Cartridge into the instrument to confirm the dialog.

3 Slide the instrument door open.
4 Orient the MACSQuant Tyto Cartridge so that the Tyto owl image is in the upright position. Place the
cartridge in the right hand side slot of the instrument stage. Do NOT push the cartridge downward. You will

SET UP A SORT

hear a click as the cartridge automatically locks into position.

3

5 The door closes automatically. The handle flashes red, and an alarm sounds 10 seconds before
closure. Hold the door in place if more time is required for the insertion of the cartridge.

Note:

If the MACSQuant® Tyto® Cartridge is installed correctly, the status bar indicator will turn blue,
showing Cartridge locked: ready to start measurement.

3.4

Initialize data acquisition
1 In the Experiment tab in the side panel, specify the details of your experiment e.g. File name, Project
name, and Sample ID (Figure 3.1).

Figure 3.1: The experiment tab
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2 Select the sorting mode in the section Sort control.
3 Select either Yield, Purity, or Balanced mode. In Yield mode, the sorting algorithm specifically selects all
events that are determined as positive events. In Purity mode, emphasis is on selecting single isolated
positive events to increase the purity of the positive sort population. Balanced mode is a balance between
purity and yield.

4 Set the Processing volume. After this volume has been processed by the MACSQuant® Tyto Instrument,
sorting is finalized automatically, and the cartridge is ejected.
5 Click the Start button in the lower right corner of the instrument status bar. Automatic cartridge
alignment will be initiated, the input chamber is pressurized, media flow starts and lasers are turned on.
S

SET UP A SORT

The orange touchscreen monitor displays the camera live view of the sorting mechanism in the
Cartridge.

3

Figure 3.2: Camera live view of the sorting mechanism in the

3.5

S

Cartridge

Tools tab
1 To open the Flow control window, select the enable flow control checkbox in the Tools tab of the
side panel.

2 The flow control window displays the flow control parameters. By default, enable flow control is
checked and manual flow control is available during acquisition ( Figure 3.3). Either target sample pressure
or target transit time can be set manually. The transit time is determined as the time between passing the
first laser and reaching the sort valve. For the MACSQuant Tyto, the optimal target transit time between
two adjacent lasers is determined at 40 µs at a flow rate of 4 mL/h.

Note:

During sorting, flow control is set to automatic control for best performance.

17

SET UP A SORT

Figure 3.3: Flow control window

3

3.6

Adjust settings
1 Under the Channels tab in the side panel of the user interface, adjust the PMT gains to visualize the desired
cell populations in the pre-set plot displays. Adjustment can be performed by left-clicking the button
behind the relevant channel and moving the slider up or down. Pressing the arrows changes the value by 1,
clicking the slider changes the value by incremental steps of 10.

Note:

If instrument settings have been set up during compensation, do not change the PMT gains since this
abolishes the compensation completely.

2 Check, and if necessary, adjust the gates so that they completely surround your target population. You can
move a gate by clicking and holding it. If necessary, adjust the gate size by left-clicking the size handles in
the corners of the gate and dragging the gate.

Figure 3.4: Gating strategy around a CD45+/CD3+/CD4+ population

3 When the Clear button in the instrument status bar is pressed during acquisition, all current events will be
removed from the analysis view. Under Edit > Options > Software > Acquire you can define whether

or not the events that are not available in the analysis view are removed from the data file as well.

4 Adjust the Trigger channel threshold to remove noise events. In the example the trigger channel
threshold was set at 10.00.

5 Modify the Cell speed channel threshold to optimize the valve timing to the population of interest. In
this example the cell speed threshold is set at 50.00.
For a detailed description on trigger and cell speed channel please refer to chapter al e timi
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, page 21.

Start sorting
1

Note:

3.8

Click on the double arrow icon in the instrument status bar to Start sorting.

In the nstrument status bar, the rate parameter changes into sort rate.

Stop sorting and eject the

S

The cartridge will eject automatically after the time required to run the volume entered in the Processing

volume text field. By default the cartridge is run at a constant flow rate of 4 mL/h.
SET UP A SORT

3.7

1 Click on the Stop button to abort the sorting process.
2 Slide the instrument door open and remove the cartridge.
3 Continue with recovering the sorted cell sample from the

S

artridge.

3
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4
Valve timing

In the following, we explain the main sorting parameters unique for the MACSQuant® Tyto® Instrument (e.g.
VALVE TIMING

trigger channel, trigger channel threshold, cell speed and cell speed threshold in detail and how to set these
parameters to optimize your sort performance.
The heart of the MACSQuant Tyto Instrument is the MACSQuant Tyto Cartridge with the world's fastest
mechanical sort valve. For sorting, cells are loaded into the input chamber and filtered air is applied to the
input chamber. Driven by the small air pressure (< 3 psi, fluorescently labeled cells flow from the input

4

chamber, via a microchannel, through the microchip and by default finally towards the negative collection
chamber. In front of the sorting valve, which is located in the microchip, cells are interrogated by three lasers.
Fluorescent and scatter light signatures caused by the laser interrogation are used to select target cells. To
redirect a target cell into the positive collection chamber, the MACSQuant Tyto Instrument applies a magnetic
field to the microchip that triggers the sorting valve to open and change the flow from the microchip towards
the positive collection chamber. Functioning of the sorting valve is fully based on the trigger and cell speed
properties.
In the following, the different steps in setting the trigger and cell speed properties are explained along the
example of sorting CD45+/CD3+/CD4+ cells based on the CD45-PE, CD3-VioBlue and CD4-APC fluorescent
antibody panel.

4.1

Trigger and cell speed channel
Accurate timing of sort valve opening in the MACSQuant Tyto Cartridge is accomplished by precisely predicting
the arrival of a target cell in front of the valve. To predict when a target cell is arriving in front of the valve, the
speed of each cell, or Time of Flight (TOF), is determined. To determine the TOF, the time it takes for a cell to
travel between two adjacent lasers, is measured on two PMT channels: The trigger channel and the cell speed
channel. The trigger channel defines the first PMT channel used to determine speed and represents the starting
point of measurement. The advanced sorting algorithms of the purity and balanced mode are based on the
trigger channel. Therefore, it is a prerequisite that this channel can detect both non-target cells and target cells.
The Trigger channel can be set in the Channels tab of the side panel.

1 Select the radio button behind the channel that you wish to set as a trigger channel (Figure 4.1). In this
example, the B2 channel (CD45-PE) was set as the trigger channel.
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VALVE TIMING

4
Figure 4.1: The channels tab

4.2

Trigger threshold
The trigger threshold states the mean fluorescence intensity (MFI) border when to classify a particle passing the
trigger laser as an event and acquire data from this event. All measurements below this trigger threshold will not
be visible on the instrument and will neither be stored nor taken into account in sorting modes.

1 Set the trigger threshold by entering a value. Default value is set at 1.00
In this example, a trigger threshold of 10.00 is selected (see Figure 4.1.) to remove noise events. A visualization
of the trigger threshold is shown in Figure 4.2. None of the particles left of the trigger threshold are displayed,
stored or taken into account in sorting modes.

Figure 4.2: Visualization of the trigger and cell speed thresholds.

4.3

Cell speed channel
The cell speed channel represents the "end point" of the speed measurement. Preferably, the trigger and cell
speed channel are selected based on adjacent lasers and closest to the sort valve for optimal cell speed
determination. This is due to variance in the flow speed within the microchannel of the

22

S

Figure 4.3 shows a schematic overview of the three recommended trigger cell speed combinations. The table

VALVE TIMING

in Figure 4.3 indicates the options of available cell speed channels depending on a specific trigger channel.

Figure 4.3: Scenarios to determine the Time of Flight of cells by selecting the optimal combination of trigger and cell speed channel

4

1 Select a cell speed channel by choosing a PMT channel from the drop-down menu (Figure 4.1, cell speed
channel) located under the Cell Speed Threshold header. In the example, we are sorting
CD45+/CD3+/CD4+ cells.
The CD45-PE marker has been selected as trigger because it allows to differentiate debris from cells and, in
addition, detects both non-target cells and target cells. CD45-PE is excited by blue laser and has therefore
been selected as trigger laser.
In Figure 4.3, row 2, for instance, the blue laser is selected as trigger laser. In this case, either the red or the
violet laser can be selected as the cell speed laser for accurate cell speed detection. In our panel, CD3VioBlue (V1 channel and CD4-APC (R1 channel can be selected as the cell speed channel as both are
excited by lasers which are adjacent to the trigger laser. Valve timing is more accurate if the cell speed is
determined using the lasers closest to the sorting valve. Therefore, we select the violet laser as the cell speed
laser and set our cell speed channel on V1.

4.4

Cell speed threshold
The time that cells travel between the trigger channel and the cell speed channel is called the time of flight
(TOF. All cells exceeding the cell speed threshold are considered in the determination of the average TOF. The
cell speed threshold is the MFI border above which cells are taken into account for measuring the average TOF.
According to this average TOF, the sorting pressure on the input chamber is automatically adjusted. By setting
your cell speed threshold just below your population of interest you can adjust the flow in the sort channel to
optimal conditions for your target population to have the most accurate sort performance. Furthermore, you
can maximally reduce the effect of noise on determining the average TOF.

1 Enter a specific value under the Cell Speed Threshold header to set the cell speed threshold.
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In this example a cell speed threshold of 50.00 is selected ( Figure 4.1 and Figure 4.2). Since our sort gate is on
the CD45+/CD3+/CD4+ population we would like to have optimal sorting conditions for this target population.
When setting the cell speed threshold to 50.00, the CD45+/CD3- population is not taken into account to calculate
the TOF in the channel and therefore valve timing in the microchip will be optimized to the target population.

4.5

Valve opening and closing times
When the TOF of an individual cell is determined, the opening and closing times of the sorting valve are
automatically set relative to the sorting TOF of this individual cell. This is done for every target cell individually
for optimal sort performance. Choose your trigger and cell speed channel wisely, since they strongly impact and

VALVE TIMING

determine your sort performance.

4
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5
Compensation procedure

COMPENSATION PROCEDURE

With multicolor flow cytometry, detection problems may arise when the emission of one fluorochrome spills
over into the detector designed to collect the emission from another fluorochrome. Compensation is the
process of correcting this spillover and is performed by first assessing the spillover of single fluorescent labeled
controls into all detector channels. In a perfect world without spillover, in a channel dedicated to detect another
dye, no difference in median fluorescence intensity should be observed between the negative and positive
population. By comparing the median of the negative and positive population, insights are generated regarding
the amount of spillover. By equalizing the median of both populations using a compensation factor, the
spillover in this channel can be corrected. In a compensation procedure this is performed for all dyes separately.
Combining the compensation factors compensates the multicolor sample of interest.

5
The basic steps of a compensation procedure on the MACSQuant® Tyto® Instrument are as follows:

5.1

l

Label compensation beads and cell sample with the fluorescent markers,

l

create a workspace and set PMT voltages based on the cell samples,

l

perform the compensation using the compensation beads, and

l

measure the sample with compensated settings.

Compensation bead preparation
Compensation on the MACSQuant Tyto Instrument is performed using compensation beads, preferably
MACS® Comp Beads. These beads can be loaded with antibodies to generate a distinct positive population. A
blank MACS Comp Bead population serves as the negative population. In order to reduce the fluorescent
signal on the calibration beads to a level comparable to that of the actual cell sample, the fluorescent
antibodies are diluted with a non-fluorescent antibody first, before loading them onto the compensation
beads.

1 Create a mastermix for each sample antibody by diluting it 1:10 with an unconjugated CDx antibody.

Note:

For some antibody conjugates (e.g. PE and APC) it might be necessary to dilute the antibody even higher.

2 For each fluorochrome-conjugated antibody to be used in the experiment, label a separate 5 mL sample
tube and prepare the equivalent amount of 2 mL safe-lock tubes.

3 Add 200 µL of the MACSQuant® Tyto® Running Buffer to each safe-lock tube.
4 Add 20 µL of mastermix to the appropriate sample tube.
5 Add two full drops of both the blank beads and the MACS® Comp Beads (anti-human Igk) to each tube. One
full drop is approximately 50 µL.

25

6 Mix well and incubate for 10 minutes in the dark at room temperature (19-25°C). Shake sample during
incubation.

7 Add

S

unning Buffer to a total volume of 2 mL and transfer the samples into 5 mL sample

tubes.

5.2

Sample preparation
To set the PMT voltages in the proper range for the target cell population, cells of interest are counted, split in
different samples and stained with a single antibody.

1 Prepare a single-cell suspension and determine cell count.
COMPENSATION PROCEDURE

2 Prepare samples with 2x106 cells each and centrifuge at 300g for 10 minutes. Aspirate supernatant
completely.

3 Resuspend cell pellet in 90 µL

S

unning Buffer and add 10 µL of the appropriate antibody

conjugate.

4 Mix well and incubate for 10 minutes in the dark in the refrigerator (2-8 °C).
5 Wash cells by adding 1-2 mL MACSQuant Tyto Running Buffer and centrifuge at 300g for 10 minutes.
Aspirate supernatant completely.

6 Resuspend cell pellet in 2 mL MACSQuant Tyto Running Buffer. Proceed with compensation procedure.

5

5.3

Instrument Settings
To display the sample cell population in the proper range, the single-stained cell samples are used as a reference
to set the PMT gains.

1 Open a new analysis window and set up an appropriate analysis, e.g. SSC vs every fluorescence channel.

2 Set the trigger on BSV and use BSB for timing.
3 Place the MACSQuant® Tyto® Cartridge loaded with the first single-stained cell sample in the MACSQuan Tyto
Instrument.

4 Click the Start acquisition button.
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5 In the Channels tab in the side panel, adjust the voltage of the main fluorescence channel targeted by this
particular fluorescent dye. Move the positive cell population to a median fluorescence intensity between 102
and 103.

Note:

Do not use PMT voltages higher than 700 V to minimize spillover. For the dim or negative markers, adjust
the voltages a little bit higher than usual.

6 Go to the Tools tab and click on the Flow control button. Check if the transit time of cells is 40 µs.
7 Click the Pause button to change samples, empty the input chamber and fill the next single-stained cell

5.4

COMPENSATION PROCEDURE

sample. Repeat step 3 to 7 for every fluorescent marker.

Setting compensation values
After setting the PMT gains based on the fluorescence intensity of the single-stained cell populations,
compensation is performed using the single-stained compensation beads.

1 Set a new group of analysis windows according to the screenshot below. This analysis template shows one
plot with backscatter versus side scatter to select the bead population. More importantly, in the other plots,
the main fluorescence channel (y-axis) is displayed versus the spillover channel (x-axis) in order to visualize
spillover.

5

2 Load your first sample of single-stained compensation beads in the input chamber of the MACSQuant®
Tyto® Cartridge and load the cartridge in the MACSQuant® Tyto® Instrument.

3 Click the Start button to initiate acquisition of your first sample of single-stained compensation beads. In
this example we used FITC single-stained compensation beads.

4 Draw a scatter region around the bead population within the BSV versus SSC dot plot. This will be P1.
5 Display events in P1 region in the main fluorescence channel versus spillover channel dot plot by selecting
the P1 region from the dropdown menu of the plot header.

6 The analysis template below shows the dot plots of FITC single-stained compensation beads. When you look
at the PE-H vs FITC-H channel, spillover of the FITC signal in the PE channel is clearly visible. You can
observe here that as FITC fluorescence intensity increases, PE fluorescence intensity increases, too. In
addition, in the PerCP-Vio700 versus PE and the PE-Vio770 versus PE channel, a range for the PE signal can
be seen. Since we do not have a PE fluorescent dye in this sample, this is an indication for spillover in the PE
channel. In the alternative view (right side) the medians of the B2, B3, and B4 channels of the negative and
positive bead populations of FITC are shown. The difference in median of these channels confirms spillover.
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7 Open the Compensation matrix by clicking the Instrument settings button located in the Toolbar

COMPENSATION PROCEDURE

and mark the Matrix checkbox in the subsequent screen.

8 To add compensation to the combination of channels in the plot, choose the appropriate cell in the matrix.
The columns represent the measured fluorochrome, the rows represent the detection channels, where the
spillover fluorescence should be corrected. E.g., to compensate a FITC-stained sample against the PE

5

channel, go to cell FITC/B2 and adjust the value to achieve equivalent median fluorescence intensity values.

9 Adjust the matrix values to compensate the specific channel.
Note:

Increase the value if the median of positive population is higher than the median of negative population.
Decrease the value if the median of positive population is lower than the median of negative population.

10 To inspect the compensation, press the Clear button to visualize only the latest acquired events.
11 Adjust values for other spillover channels, if necessary.
Note:

Keep the "1000" values in the diagonal on the compensation matrix.

12 In the figure below the FITC single-stained compensation beads are visualized after compensation. Now in
the PE-H versus FITC-H dot plot, all events are PE negative. In the PerCP-Vio700 versus PE and the PE-Vio770
versus PE dot plots, no positive signal can be observed confirming a succesful compensation. In the
Alternative view (plot on the right side) where the FITC signal is displayed in a histogram, all potential
spillover channels (B2, B3, B4) have a comparable median if you compare the negative FITC population with
the positive FITC population.
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5

13 Once compensation is adjusted for this fluorochrome, click the Pause button and retrieve residual sample
from the input chamber of the MACSQuant® Tyto® Cartridge.

14 Rinse with 0.1 mL Tyto Running Buffer and pipet the next single-stained bead sample into the MACSQuant
Tyto Cartridge and continue acquisition by clicking on the Pause button again.

15 Load the next single-stained bead sample and perform above steps for all markers individually.
16 When finished compensating, save your settings as instrument setting and analysis template separately.

5.5

Measure sample of interest
Since the compensation factors are set for all fluorescent markers, you are now ready to sort your sample of
interest.

1 Rinse the MACSQuant Tyto Cartridge with 0.1 mL MACSQuant® Tyto® Running Buffer and pipet the cell
sample, stained with the complete antibody panel in the input chamber of the MACSQuant Tyto Cartridge.

2 Sort this sample using your previously saved instrument setting.
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6
Data storage

The MACSQuantify™ Tyto® Software enables users to create different files for efficient use of the MACSQuant®
Tyto® Instrument, e.g. experiment files, analysis template, instrument settings file, data files and workspaces.
This quick guide explains the different types of files and how to open, save, copy, delete, and export the
different files. The basic folder structure is explained and finally how to back up your data.

File types

DATA STORAGE

6.1

Within the MACSQuantify™ Tyto® Software there are three levels of filetypes (Figure 6.1). On the lowest level,
data files are stored consisting of the raw data of an experiment and are stored under the .mqd format. On a
higher level, reference to multiple data files can be stored in a sample list. On this same level, different aspects
of a sort are stored separately: experiment files, analysis templates and instrument settings. Experiment files
comprise all experiment data parameters defined for a particular experiment. Analysis templates comprise files

6

of pre-defined analysis layouts and are created by defining views (plots, histograms, statistics and tables) and
gating strategies. An instrument settings file consists of calibration settings (PMT voltage values, channel
scales), compensation matrix and trigger selections that are important for data acquisition of specific
experiments.
At the highest level, a workspace file exists, all encompassing, representing experiment files, analysis templates
and instrument settings. In addition, a workspace saves all samples displayed in the sample list. All these files
are saved with the .cfg filetype .

Figure 6.1: File type structure overview

6.2

File locations
In the MACSQuantify™ Tyto® Software, files can be saved and opened in three locations: the Public, Private
and External location. Files are saved within the cap folder structure on the MACSQuant® Tyto® hard drive. Files
under the Public location in the MACSQuantify™ Tyto® Software are located in the cap/global folder and can
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be accessed by any user. Files in the Private location of a user are found in cap/user/username ( Figure 6.2)
and are only accessible by the logged-in user. The External location is linked to external storage spaces such as a
USB device or external hard drive.

Figure 6.2: Folder structure

6.3

Working with files
The file types orkspace, nstrument settings, xperiment and nalysis template can be stored and loaded with

DATA STORAGE

the pe and Sa e dialogs.
To save nalysis templates, you must switch to nalysis

6.3.1

ode.

Save files
1 Click the Save button in the toolbar to save experiment files, analysis templates, instrument settings or
workspaces.
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2 Choose orkspaces, nstrument settings, xperiments, or nalysis to save the file type.
3 If necessary select the desired location (Public, Private, External).
4 Assign an appropriate file name and click Save.

Note:

Data files are saved automatically. Saving Workspaces during acquisition is not possible, Analysis templates
can only be saved in Analysis mode.

6.3.2

Open files
1 Click the Open button in the toolbar to open experiments, analysis templates, instrument settings, data
files or workspaces.

2 Select Workspaces, Instrument settings, Experiments, Analysis templates, or Data files on the left-hand side
of the dialog box.

3 Select the appropriate file location (Public, Private or External).
4 Choose the desired data file. Multiple files can be opened at once by holding t l or S i t during selection of
the data files.

5 Confirm your selection with Open.

6.3.3

Copying or deleting files
To transfer data files from the MACSQuant® Tyto®
S

S

contains a separate dialog box.

1 To transfer data from the MACSQuant Tyto
the device to be recognized.

2 Go to File > Copy to open the dialog box.
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to a remote storage location or delete files

to a USB storage device, insert it into an USB port and wait for

3 Choose the destination location from the available drop-down menu in the dialog box.
4 From the drop-down list, select either:

l

To: The selected files in the folder structure of MACSQuantify™ Tyto® Software are copied to the selected
destination. Please note that the according folder structure is also preserved at the destination location.
From: The selected files will be imported. It is necessary to have the files organized in the same folder structure as
on the destination location of the MACSQuantify™ Tyto® Software.

DATA STORAGE

l

5 Select the desired files or folders by checking the checkbox.

Note:

Select multiple files by pressing the Ctrl key or Shift key. Select multiple files by drawing a rectangular
using the mouse while pressing the space bar of the keyboard. The checkbox displays a green check mark if

6

all files of a folder are selected and a green square if only some files of a folder are selected.

6 Click Copy. To remove folders or files that have been copied, click Delete.
7 When all files are copied, a report dialog box appears. Close the box to execute another copy or deletion
command.

8 When using a USB storage device, the option Close and eject is available to allow safe removal of the
device.

6.3.4

Export data files as FCS
All acquisition data is stored in the .mqd file format. However, by checking the box Export as FCS under Edit

> Options > Software > Acquire, the default format is FCS. MQD files can be exported as FCS or CSV files at
any time by right-clicking on opened or added data files in the Samples tab and selecting Export sample.
Select the desired file type (.fcs. or .csv) from the drop-down list. If a gating strategy was applied to any of the
data, MACSQuantify Tyto Software will create a separate FCS file for each gated population. If only one FCS file
is required for the original data file, check the box Skip subpopulations. The FCS files will be stored to the
same folder as the original MQD data files were opened or added from.

Figure 6.3: Export data files as FCS.
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6.4

Data backup
In order to backup data from the MACSQuant® Tyto®, a mass storage drive must be connected or a network
location designated.

Note:

6.4.1

Only administrators can assign a public backup folder.

Data backup to a network location
To designate a network location for data backup, login as an administrator, then click Edit > Options

(default) > Files. Choose a location on the network that can be accessed by all users of the MACSQuant®
Tyto®. Individual users can format their own personal network folder within the designated backup folder by
clicking Edit > Options > Files.

Note:

The default backup parameter settings can be defined by an administrator clicking Edit > Options

(default) > Backup.

DATA STORAGE

When entering the network location, the full path, starting with \\, needs to be entered. You can also select the
destination folder via browsing. Depending on your specific network structure, access of the backup folder
might require a logon name and a password, which can differ from the user login for the MACSQuant® Tyto®.
Therefore you can also set the Logon name for your network.

1 Click on the Backup button from the toolbar.

6

2 Select the designated drive and click OK.
3 If requested, enter password when prompted.
4 During backup, all successful backed up .mqd files will be deleted from the MACSQuant® Tyto® Instrument,
if you selected Delete cloned files. However, all .fcs files will need to be deleted manually.

5 When the backup is complete, a dialog box confirmation appears.

Note:

If a private backup option, such as a USB storage device, has been defined, it will also appear as a source
or destination in the Copy dialog.
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7
Gating strategies

7.1

Gating strategies
To perform a sort on the MACSQuant® Tyto® Instrument, a gating strategy needs to be set to identify your
population of interest. This Short Instruction gives an overview of the gating tools present in the
MACSQuantify™ Tyto® Software and how to use these. In addition, the most frequently used tools to visualize
or export your gating strategy are shown.

Gating tools
GATING STRATEGIES

7.2

1 To create a gate or region, click on one of the Gating tool buttons from the Toolbar or choose the
gating tool from the Edit menu.

7

2 If using ellipse, rectangle, quadrant or interval, left-click on a plot and start dragging a gate. Release
the left button to finish drawing. In below example CD45/CD3/CD4 stained PBMCs were used in order to sort
the CD45+/CD3+/CD4+ population. First we select the CD45+ cells using an ellipse gate in the CD45 versus
SSC plot.

Note:

Interval regions can only be applied to histograms

3 To make the second gate dependent on the first gate, left-click the header of the subsequent plot and select
to display only the events in the P1 gate.

4 The header now indicates that in this plot the view is live/P1. To select the CD3+/CD4+ populations we use a
polygon gate.

5 Select the polygon gate from the Toolbar menu.
6 If drawing a polygon, left-click once to start drawing the first point. Move the cursor and left-click again to
draw the next point. Continue as desired. Double-click to draw the last point and finish the gate.

7 When the gate is selected, the edit points can then be used to adjust the size and shape.
8 Click and drag the gate to move it to a new position.
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Note:

It is not possible to add additional edit points to a polygon once it is created.

7.3

Copy gates

7.3.1

Copy gates via drag and drop
Regions or entire gating strategies can be copied to other files or moved to other areas of the gating strategy.

1 After establishing a gating strategy using one data file. Click on the highest region within the hierarchy

GATING STRATEGIES

shown in the sample list that you would like to copy. Here the P1 region of data_file_1 is selected.

2 Drag it onto a file requiring the same gating strategy. The same hierarchy and any name or color changes
will be applied to the new file.

7.4

Move a region within a gating hierarchy
1 To change the hierarchy level of a region, click on a region and drag it to the desired hierarchy level within
the gating strategy in the sample list. In this example, the P2 region was moved up one level.

7

A copy of the original region is created with the same coordinates and plot association as the original region but
different statistics and named with an incremental number. In this case P3.

Note:

If you change the name, color or Not gate properties of one of these regions under region properties,
both regions will be changed.
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2 To uncouple the regions, select within a dot plot one of these regions and drag it to a new position. A
prompt appears whether to apply this change to only the current sample or to all samples. If you select
Current here, the regions are uncoupled.

7.4.1

Copy/paste regions
Copy a region from one plot and paste it to the same or compatible plot. A region from a dot plot can be
pasted to a dot plot or density plot, but not to a histogram. The same physical coordinates are used for the
region, even if the plot has different scales.

GATING STRATEGIES

3 Right-click on a dot plot and choose Copy.

7
4 Right-click on a compatible plot and choose Paste. This new region is completely modifiable using the edit
points and Region properties.

Note:

Using this method, region properties of the new region are set completely independent of the original
region; this is in contrast to the Move a region function.
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7.5

Delete gates

GATING STRATEGIES

To delete a gate, do one of the following:
l

Select the gate in a dot plot and press the delete key, or click the Delete region button in the Toolbar.

l

Right-click in the Samples list on a gate and select Remove.

l

All regions under a file or under other regions in the sample list can be deleted by right-clicking on the file or
the top region in the hierarchy and choosing Clear subgates.

7

7.6

Not gates
Not gates are used to eliminate a cell population from sorting and are indicated by a dashed line.

1 Draw a region or gate in any random shape around the population to be excluded from analysis.
2 In the Samples list, right-click on the region of interest.
3 Select Region properties from the drop-down list.

4 Check the box Not. This region is now excluded from sorting. (Optional) Select a color and/or name the Not
gate as desired.

5 Click Apply and OK. The Not gate is now depicted as a dashed line.
6 In subsequent plots, gated cells are excluded.
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Change region properties
The properties of a region such as the color, region name and the Not gate property can be set in the region

properties.
1 Right-click on the region name displayed in the Samples list or on the activated gate in the dot plot to
change the region properties of that specific region.

2 Select Region properties. Adjust as desired and click OK.
3 To change all other Region properties more specific for the entire dot plot, click the I button next to the
plot. Adjust as desired.

GATING STRATEGIES

7.7

7
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